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WIA (Windows Imaging Architecture) is a driver and API, developed by Microsoft. It only works on 

the Windows operating system. The entire development of the driver is tied to Microsoft's 

objectives and does not really take into account the demands of scanner developers. 

 

2.3 Scanning Resolution and Quality 

Scanning works on the principle of detecting light reflected off paper or picture.  

The entire surface of the sheet is divided into small pixels. Each pixel is determined by its position, 

brightness level and color (color scanning). Resolution is the number of pixels per unit of length.  

It is usually written down as number of dots per inch (dpi).  

A document which is divided into more pixels has better resolution and consequently its 

conversion into digital form is of higher quality. The scanning resolution is conditioned by the 

scanner technology. Scanners support a resolution from 100 to 1600 dpi. For the needs of 

archiving a non-image document, a resolution of 300 dpi is sufficient.  

Scanning with a resolution of under 200 dpi may result in unreadable conversion of archived 

documents. Scanning with more than 300 dpi is sensible if the original text on paper is of poorer 

quality or when you wish to convert an image of a document into digital form with very high 

resolution. 

 

2.4 File Compression and Size 

When scanning, a dot on paper is being copied to a digital memory unit.  

In the case of black-and-white copying this unit is 1 bit, while in the case of gray or color copying it 

can be a byte or bytes. The quantity of color or level of brightness which is captured with a 

scanner is called color depth. Greater color depth gives a broader range of various colors and 

consequently means greater memory usage. The first row in the table below gives an example of 

how color scanning can use up to 15 MB of memory. 
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In the next step customize the displaying and adding of IMiS®/Scan shortcuts. 
 

 

 

You can choose between the following options: 

• "Start menu items" enables the display of the IMiS® icon in the "All Programs" menu; 

• "Desktop items" installs the IMiS® icon on the desktop; 

• "Quick Launch" displays the IMiS® icon in the quick launch taskbar. 

 

The final step of the installation wizard is the confirmation of settings prior to installation by 

clicking on the "Install" button. 

 

The installation procedure for the IMiS®/Scan software product commences;  

the progress bar shows information about the transfer of files to the appropriate locations. 
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Installation is complete when the last display box appears, which you close by clicking on the 

"Finish" button. 

 

 

5.2 Administrative Installation 

For specific installations you need to manually specify the location of certain files and prepare 

appropriate records in the Windows registry. 
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Note: Selecting high resolution has a great impact on the size of the scanned document file. 

For more information see chapter Scanning Resolution and Quality. 

 
“Patterning” 

By selecting patterning, you can replace the color or gray with a suitable pattern of pixels of a 

lower color depth. The values in the drop-down menu depend on an individual scanner. 

 
 

Example: gray can be patterned as a chessboard of small black and white squares. 

 

“Brightness” 

Brightness affects the sensitivity of the scanner to non-white dots on the sheet.  

Greater brightness scans an image with fewer black or color dots. Reducing the brightness gives 

the scanned document a more "smudged" look. That is because the non-white dots are 

emphasized. 

 

“Sharpness” 

By setting the sharpness of a scanned document, you increase/decrease the difference between a 

light and dark dot. For better scanning of documents with poorer quality the correct ratio 

between brightness and sharpness is especially important. 
 

Example: a darker document is scanned with smaller brightness, whereas brightness is increased for a 

lighter document. 
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“Two-sided scanning” 

If the scanner enables two-sided scanning, you can select the option "Two-sided scanning".  

When scanning individual sheets of paper, it will scan both pages. IMiS®/Scan performs two-sided 

scanning of sheets only if you apply "Scan multiple pages" in the "Scan" menu. 

When performing two-sided scanning, it is recommended that you use the "Remove empty pages" 

setting, which is not enabled by all scanners. 

 
“Separate scanning of odd and even pages” 

IMiS®/Scan also enables two-sided scanning on one-sided scanners.  

Select the option "Separate scanning of odd and even pages". First scan the odd pages of the 

document, then turn the document around and scan the even pages. 

IMiS®/Scan will automatically insert the pages into the correct spot in the document. 

 

6.3.2 Setting Options 

The IMiS®/Scan software product enables many customizations. 

In the taskbar, right-click above the IMiS® icon ( ) and select "Options..." from the menu. 

 

 
 

A dialog box appears showing all the settings, arranged into categories. 

By clicking on the "Confirm" button, you save the settings to their subkeys and fields in the 

Windows registry. 

By clicking on the "Cancel" button, all the currently changed settings are discarded. 

 
When reopening the settings, the user is shown by default the category which he or she opened 

when last checking the settings. 

 

The setting "Options..." is also accessible via the "Tools" menu. 
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6.3.2.1 Setting Options – General 

When opening the "Options" dialog box for the first time, the "General" category appears.  

This group contains the settings that influence the display and operation of the IMiS®/Scan 

application. 

 

 

In the "General options" group the following settings options are available: 

 

“Run automatically at Windows startup” 

The IMiS®/Scan application is launched automatically at the next Windows operating system 

startup and is present until you close it manually. 

 

“Associate with documents of type <.TIF> and <.TIFF>” 

All files ending in TIF or TIFF will be opened by the IMiS®/Scan application. 

 

“Close document with the <ESC> key” 

A document open in IMiS®/Scan can also be closed by pressing the <ESC> key.  

If the document has been changed, a dialog box appears with the option of saving the changes. 

 

“Save the size and position of user window” 

When exiting the currently open user window, the size and position of the IMiS®/Scan window are 

saved. The next time you open the document, the user window will appear in the same spot and in 

the same size. 
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The size and position of the user window are saved in binary value to the Windows 

registry in the Image Window field, in the <path>\IMiS subkey. 

 
“Hide menu, use only toolbars” 

For the image of the document in the user window to be bigger, you can hide the menu. 

Afterwards IMiS®/Scan is used solely with the commands in the taskbar. 

The menu reappears when you disable this option. In the taskbar, right-click above the IMiS® icon 

( ) and select "Options..." from the menu. 

 

 

 

“Show documents in the taskbar” 

A button appears in the taskbar for each document open in IMiS®/Scan.  

 

“Close document when COM object is destroyed” 

A document, which is shown in IMiS®/Scan and opened via Windows COM technology, is 

automatically closed when the COM object to which this document was connected is destroyed. 

 

“Hide splash screen at startup” 

The displaying of the splash screen when launching the IMiS®/Scan application is disabled. 

The settings are saved in binary form to the Windows registry in the Preferences field in 

the <path>\IMiS subkey. 

 

“Enable operations log” 

In the "Log" group you can specify the path of the text file in which you wish to log the operation of 

IMiS®/Scan. Select the operations level to log in the "Level" drop-down menu.  

  



IMiS®/ Scan & IMiS®/View Manual Version 9.10.1910 
 

2018 ©  Imaging Systems, Inc., All rights reserved. 45 
 

You can choose between the logging of critical errors only and the detailed logging of operation. 

 

The name of the logging file is imis.log. The option "Enable operations log" is recorded in 

the Windows registry in the LogEnable binary field in the <path>\IMiS/IMiSScan subkey.  

In this subkey the logging level is entered in the LogLevel text field. The directory in which the log is 

saved in recorded in the Windows registry in the LogDir text field in the <path>\IMiS/IMiSScan 

subkey. 

The <path>\IMiS/IMiSScan subkey also contains the LogSize numeric field, which records the size of 

an individual log file. The default file size is 1Mb. When this size is exceeded, all the log files are 

rotated. The rotation cycle is recorded in the same subkey in the LogCount numeric field. The 

default rotation value is 10. 

 

6.3.2.2 Setting Options – Document 

The "Documents" category from the "Options" dialog box is used when selecting the file format 

for new documents and when selecting the settings for printing newly-added pages.  

New pages can be created by scanning a document or by selecting "Paste" via the clipboard. 

The contents in the clipboard are saved in the format selected in the settings. 
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In the "Save" group you can select a format for saving documents: 

• "Multi-page TIFF file (*.tif)" for creating multi-page TIFF documents; 

• "Adobe PDF file (*.pdf)" for creating image documents in the PDF/A-1b standard. 

 

In the "Compress new pages" group select the compression method for each type of color image. 

The compression modes available depend on the selected format for saving. By changing the 

format, you also change the compression mode for new pages. 
 

When scanning black-and-white documents with the IMiS®/Scan application, it is 

recommended that you select the saving of TIFF files with G4 compression. For the scanning of 

color documents, it is recommended that you use a Wang-compatible JPEG format. 
 

For simpler transfer of scanned documents between applications and operating systems  

it is recommended that you select the saving in PDF file format with the default compression 

method settings. 

See also chapter File Compression and Size. 

 

Warning: Changing the saving mode does not affect the currently open documents, but only those which will 

be created after the "Options" dialog box is closed. 
 

Settings are recorded in binary form in the currently selected profile in the Windows 

registry in the Preferences field in the <path>\IMiS\IMiSScan\<profile name> subkey. 

 

6.3.2.3 Setting Options – Annotations 

The "Annotations" category from the "Options" dialog box contains certain settings for 

bookmarks in TIFF documents. 
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Annotation in the shape of an ellipse. It is used for drawing ellipses. In the right pane you 

can set the background color of the ellipse. 

 
Rectangular annotation. Draw a rectangle in the image. As with the ellipse, fill the rectangle 

with the desired background color. 

 
Line breaking tool. This annotation is used for drawing broken lines. Drawing is concluded by 

double-clicking on the left mouse button in the desired location. In the right pane set the 

color and/or thickness of the line and/or background. 

 
Image annotation. This annotation is used when wishing to insert an image annotation into a 

document. If the file path to the image is not specified in the right pane, a dialog box for 

opening files appears, in which you select the path to the image file. IMiS®/Scan enables only 

the insertion of the BMP file format. 

 
Stamp annotation. This annotation is used for preselected images, which are specified in the 

"Annotations" category in the "Options" menu in the "Tools" menu. 

For more information see chapter Setting Options - Annotations. 

 
User annotations. Annotations appear which the user has previously saved and which can 

be selected for reuse. 

 

7.18.2 Editing Annotations 

In order to edit the annotation settings, the document must be in edit mode and the 

"Annotations" category must be opened in the right pane. When using IMiS®/Scan through 

another application, you need appropriate rights for editing annotations. 

For more information see chapter Setting Annotation Rights. 
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Select an existing annotation in the document or an icon in the annotations bar. The settings for 

this annotation appear in the right pane.  
 

 

 

7.18.3 Copying and Merging Annotations 

In IMiS®/Scan annotations can be copied, cut or added to other pages of the document or into 

other documents. Select an annotation by right-clicking. 
 

 

 

Select the desired action from the "Tools" menu. 
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You can merge an individual annotation in the document with the document. By doing so,  

the annotation becomes a part of the scanned document. 
 

Note: By merging annotations, you modify the document contents. 

 

7.18.4 Setting Annotation Rights 

  You can set the rights of a user for each type of annotation.  

The rights can be set only through another application. When invoking the window for setting 

rights in another application, the following options appear: 
 

 

 

You can specify for each type of annotation whether a user has the right to see it in a document 

and whether the user has the right to add new annotations to a document. 

 

Warning: During redaction you set the rights of a user for viewing the redacted contents.  

If the user does not have that right, the redaction stays in the document and the user cannot remove it. 
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7.18.5 User Annotations 

All annotations in a document can be saved for reuse. They are available to the person who saved 

the annotation. By right-clicking on the desired annotation, the "Tools" menu appears. 
 

 

 

Select "Save annotation as" from the menu and then select "New annotation". A dialog box 

appears in which you enter the user annotation name. 
 

 

 

Confirm the entry by clicking on the "OK" button.  

 

The annotation can be invoked to the document by selecting the annotation name. User 

annotations are selected by clicking on the "User annotations" icon  in the annotations bar.  

A list of saved annotations appears. 

 

The selected annotation is placed in the document in the same location as it was inserted when 

being saved. It can be manually dragged to another location in the document with the mouse. 

 

If you have selected the default option "Placing user annotations with the mouse" in the 

settings, the user annotation is not immediately placed in the document. The location of the 

annotation is selected by moving the mouse and clicking on the selected location in the document.  
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A user annotation can be selected from the drop-down menu in the "User annotations" tab under 

the "Annotations" category. 

 

 

To delete a saved user annotation, select the annotation and click on the "Delete" button.  

The user annotation is removed from the list. 

User annotations are saved in the Windows registry in the 

HKEY_CURRENT_USER\Software\IS\UserAnnot subkey. The value of each user annotation is 

recorded in the field containing the name of the user annotation. 

 

7.19 Arranging User Windows 

The easiest way to arrange several simultaneously open windows is by using the "Window" menu. 

 
 

Open documents can be arranged in one of the following ways: 

• one after another in a cascade; 

• distributed horizontally, side-by-side; 

• distributed vertically, one beneath the other. 

  



IMiS®/ Scan & IMiS®/View Manual Version 9.10.1910 
 

2018 ©  Imaging Systems, Inc., All rights reserved. 100 
 

7.20 "Help" Menu 

 

 

By clicking on the "IMiS homepage" option, the default Internet browser opens the website of 

Imaging Systems Inc. (http://www.imis.eu) 
 

By clicking on the "IMiS Manual" option, the default Internet browser opens the first page of the 

user manual. 

 

By clicking on the "IMiS Tech Support" option, the default email client creates a new message for 

the addressee  support@imis.eu. The message contents contain information about the installed 

version of the IMiS®/Scan application and utility libraries. Attached to the message is the 

operations log for the IMiS®/Scan application in connection with IMiS®/ARChive Server.  

This information helps technical support eliminate problems. 
 

 

  

http://www.imis.eu/
mailto:support@imis.eu
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By clicking on the "About program" option, the splash screen of the IMiS®/Scan application 

appears, which contains details about the application version. 
 

 

 

7.21 Electronic Signing of a Document 

7.21.1 Setting and Adding a Signature 

Documents scanned with the IMiS®/Scan application can be electronically signed. 

An electronic signature can be a mere electronic record in the document, which is not visible to 

the user, or can be graphically depicted and visible to the user when viewing the document in a 

viewer.  

Signature settings are edited in the "Signature" category in the right pane of the user window. 

 

 

 

Settings for electronic signing are possible only if: 

• the document is in edit mode; 

• a certificate is installed on the computer; 

• the document you wish to sign is not empty. 
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Before signing it electronically, select a digital certificate. The default digital certificate setting is 

selected in "Settings".  

 

Detailed information about the currently selected digital certificate can be viewed by clicking on 

the "Certificate information" button  in the "Select certificate" group.  

A window opens containing a notification and digital certificate details. 

 

In the "Signature parts" group, select which information about the electronic signature will be 

shown in the scanned document. The options are as follows: 

• text description of the digital certificate; 

• image of a handwritten signature or any other visual mark; 

• signature reason, which can be saved to be reused in the next signing session; 

• visible comments to the document. 

 

A document can also be electronically signed without any visible marks on the document. 

 

Electronic signing is performed by clicking on the "Sign" icon .  

Place the selected parts of the visible signature to the desired location in the document using the 

mouse. 

By doing so, the document is not yet electronically signed. The document is signed when it is 

saved, because then the entire contents of the document are uniformly coded, together with the 

digital certificate, and recorded into the document.  

This procedure is also temporarily executed when printing or sending by email. 
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You can add electronic signatures of other users to a document which has already been signed by 

a user. A document can be signed by several users in a row or in parallel. 

 

By clicking on the "Save" button, all the electronic signature settings are saved for later, faster 

use. Likewise preserved are the size and current position of the visible part of the signature. 
 

By clicking on the "Reset" button, the changed settings are set to their previous values. 

 

7.21.2 Showing of Electronically Signed Documents 

Before showing an electronically signed document in the user interface, the validity of the 

signatures is verified. The verification result is shown visually in the user window, next to each 

signature in the document. 
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Visual Mark Description of the Mark's Meaning 

 

The document contents have not been modified after being signed and the signer's 

digital certificate is valid. 

 

The document contents have not been modified after being signed, however, the 

signer's digital certificate has expired. 

 

The document contents have been modified after being signed or the signer's digital 

certificate is invalid.  

 

For more detailed information about the electronic signature click on the "Details« tab in the right 

pane in the "Signature" category. Signatures which are not visually presented in the document 

are also listed here. 

 

 
By clicking on the "Detailed verification" button, you activate the procedure of the detailed 

verification of the validity of the signer's digital certificate.  

 

The "Signers" group contains a tree view of all the metadata for an individual electronic signature. 

Shown is the validity of the signature, the date the signature was created, the entry of the reason 

for the signature, the signature comment, the validity of the signer's certificate, the presence of a 

timestamp, the expiration date of the certificate, the signature version, and the application with 

which it was created. 
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By clicking on the "Find signature" parameter in the tree view, a page appears in the central part 

of the user window, which contains the signature. 

 

By double-clicking on the certificate image or by clicking on the "Show certificate..." parameter in 

the tree view, a dialog box appears, containing all the details of the signer's certificate. 

 

 

 

7.21.3 Editing an Electronically Signed Document 

In the IMiS®/Scan application you can edit or electronically sign a document with your own 

signature. In both cases the document must be set to edit mode. 

This is performed by clicking on the "Enable editing" icon  in the toolbar. 

 

The following dialog box appears: 

 

 

 
Confirm the selection by clicking on the "Yes" button. 
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8.4.2 Error #201 when Saving a Document 
 

 

 

Cause: The provided IMiS®/ARChive Server profile does not exist. 

Eliminating the problem: Check the entered profile name.  

Turn to technical support via email: support@imis.eu. 

 
8.4.3 Cannot Save in the PDF File Format 
 

 

 

Cause: Unexpected error when saving and closing a new document written in the PDF file format. 

Eliminating the problem:  Shutdown and restart the IMiS®/Scan application.  

Turn to technical support via email: support@imis.eu. 

 

8.4.4 Cannot Save in the TIFF File Format 
 

 

 

Cause: Unexpected error when writing the document in the TIFF format. 

Eliminating the problem: Shutdown and restart the IMiS®/Scan application. 

Turn to technical support via email: support@imis.eu. 

 


